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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting Installation Guide. The
Insbridge Rating and Underwriting (IBRU) System is a browser-based, multiplatform insurance
rating and underwriting technology solution that provides integrated management for every
aspect of the rate definition and modification process. This guide will help with the installation of
the Insbridge Rating and Underwriting System.

NOTE: RateManager and IBFA have been tested and certified on MS Windows 2008 64-bit.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others
tasked with installing and configuring the IBRU system and associated databases.

PLANNING YOUR IBRU SYSTEM

Prior to installation, you should have an idea of the type of setup you want to create. What kind of
equipment do you have available and how many environments do you need? If you do not have
everything completely planned out, you can still proceed. Environments can be removed or added
later on. The Oracle Insurance Insbridge Rating and Underwriting system (IBRU) is expandable
and can accommodate a few different configurations.

For more on planning your IBRU system, please see the Insbridge Implementation Guide.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

o Full RateManager — This installation installs RateManager and the Insbridge Framework
Administrator (IBFA). This is for a Windows only environment using a SQL Server
database.

SoftRater Installation

o Full SoftRater for Java Installation — This installation deploys SoftRater to an
application server; WebLogic, WebSphere or JBoss, using a SQL Server database or an
Oracle database.
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Full SoftRater for Windows Node — This installation is for existing environments that
want to add a SoftRater for Windows node to an environment. This is for a Windows only
environment using a SQL Server database, or an Oracle database.

Upgrading a Current Installation

Upgrade — This installation is for existing customers and will take their current version of
IBRU up to version 04.06.00.

This guide is for a Full RateManager installation.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

IBRU — Insbridge Rating and Underwriting System. This is the entire system.

IBFA — Insbridge Framework Administrator. IBFA is an administrative tool used to
configure Insbridge applications and setup RateManager database connections. IBFA will
be located on a Windows Server machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS — Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater
engine. The SoftRater engine is a multi-platform component within IBRU that executes
the rules, rating and underwriting instructions as defined by the user in RateManager.
IBSS is usually located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

SoftRater Native — SoftRater Native is a remote instance of SoftRater that can execute
rules and rating logic in environments where access via the SoftRater web-services is not
desired or possible.

RM — RateManager. RateManager is a component within IBRU that enables users to
manage the product definition and modification process, including rating and underwriting
logic.

SR — SoftRater. The engine that executes the rating, rules and underwriting instructions
defined within RateManager. The rating environment for runtime execution and
processing of business content. SoftRater can be further defined by the operating system
where it has been loaded.

SR-WIN — SoftRater for Windows. This is also another name for IBFA.

SR-JAVA — SoftRater for Java. This is also another name for IBSS.
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o SRP — SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

o VFS - Virtual File Servers. Virtual file server management allows you to access
environments that are located on other machines in different locations where packages
can be downloaded.

o Package Location — A pointer to a location where SoftRater Packages (SRP’s) are
stored.

e Physical Environment — A physical environment is generally referred to as a physical
machine.

o Authoring Environment — The physical machine where RateManager is installed.

e Rating Environment — The physical machine(s) where SoftRater is installed. This is
typically the same as a SoftRater node.

o Logical Environment — An environment created for a subscriber in IBFA. It defines
package location, engine location and database location in addition to several other

supporting data items. This environment is used for rating and/or SRP management.
Each database connection will have a logical environment.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:

o The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for
Hardware and Software.

e You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

Boldface type indicates graphical user interface elements associated

eils with an action.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.
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Chapter 1

SYSTEM REQUIREMENTS

IBRU installers should be familiar with managing a Windows server. For help with verifying or installing
required components for Windows 2003, please see Windows 2003 Settings and Permission Notes on
page 69. For a 64-bit machine, please see Insbridge Installation for 64-bit.

Required Components

The following components are required:
o A full installation of Microsoft Windows Server 2008 or Windows Server 2003

e Microsoft .NET Framework version 3.5
e IS —Internet Information Services version 6.0 or 7.0

e For Windows 2008 Server — IIS 6 Metabase Compatibility

e For Windows 2008 Server — Web Server (IIS) — Static Content is required
e For Windows 2008 Server — WCF http activation needs to be enabled

o For Windows 2008 Server — The ASP.NET roll must be installed

¢ MSMQ — Microsoft Message Queuing Services — basic functionality only.
o JRE - Java Runtime Environment

e Insbridge User Account

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where IBRU will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

o Insbridge IBRU Install — This is required for all RateManager installations
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o SoftRater for WebSphere — This is required if you are using WebSphere
o SoftRater for WebLogic — This is required if you are using WebLogic
o SoftRater for JBoss — This is required if you are using JBoss

o Documentation — It is recommended that you download the documentation. Installation guides
and user guides are located here.

The 04.06.00-Insbridge-IBRU folder contents:

- Databases
¢+ DB2
- SoftRater — IBSR
o DDL
¢ Oracle
- SoftRater — IBSR
o DDL
0 Update:Usp_IBSR_v04.05.00.oracle
¢ SQL Server
- RateManager — IBRM
0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security —IB_CLIENT
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
0 Latinl_General_BIN
= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl1_General_CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
0 Update:Usp_IBSR_v04.05.01.sql

- IE7_IE8 Users
¢ Insbridge IE7 Active X Control Update PDF
¢ RateManager_IE7_IE8.exe

- Oracle Bl Publisher
¢ OBI_PUBLISHER.exe

- Oracle Client
¢ Oracle_client.exe

- Oracle Insurance — Insbridge Rating and Underwriting.exe

You will be required to run the installation file and create the IB_CLIENT database for any new
installation. The other folders and files may not be needed, depending upon the kind of setup you want.
Everything for a Windows only installation is in the 04.06.00-Insbridge-IBRU folder. If you want to
incorporate a Java environment, please download the corresponding SoftRater file. SoftRater downloads
are not required if you are running in Windows only.
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Quick View

RATEMANAGER INSTALLATION

Installing RateManager will require that you:
1. Set up Windows. There are three steps in setting up Windows for a RateManager deployment.

2. Install IBRU using a SQL Server Database

Setting up Windows

Step 1: Set up an Insbridge User.
Step 2: For Windows 2008, allow permissions.
Step 3: Verify SQL Server settings.

Installation Procedures — Full RateManager

Step 1: Install Insbridge Rating and Underwriting

Step 2: Configuring Registry Access

Step 3: Assigning Permissions — Windows Temp Folder
Step 4: Assigning Permissions — Insbridge Folder

Step 5: Restoring IBRU Databases in SQL Server
Step 6: Configuring Insbridge Framework Administrator
Step 7: Verifying the Component Services

Step 8: Allowing for WCF Activation

Step 9: Installing the OBI Publisher

Step 10: Starting Insbridge Services

Step 11: Performing Updates in RateManager

Step 12: Export Insbridge Registry Key for Backup
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Chapter 2
SETTING UP WINDOWS

IBRU installers should be familiar with managing a Windows server. For help with verifying or installing
required components for Windows 2003, please see Windows 2003 Settings and Permission Notes on
page 69. For a 64-bit machine, please see Insbridge Installation for 64-bit.

Windows Server should be up and running prior to RateManager being installed. There are three steps
that should be performed prior to the install:

e Step 1: Set up an Insbridge User. This is a required step.
e Step 2: For Windows 2008, allow permissions.

o Step 3: Verify SQL Server settings.

STEP 1: INSBRIDGE LOCAL USER ACCOUNT SETUP

Before starting the installation, create a local user account where the Insbridge Framework is being
installed. This user needs to be a member of the User group and requires certain privileges in order to
fully control the entire IBRU environment. For ease of installation and if the server is dedicated to the
Insbridge Rating and Underwriting System, it is suggested that this user be added to the local machine
Administrators group.

If the installer has permissions, an Insbridge user can be created during the installation.

To Create a New User in Windows Server 2008:

1. Select Start->Administrative Tools—> Server Manager.
2. Select Configuration—>Local Users and Groups.
3. Select Users.

4. Right click and select New User.
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Figure 1 Creating New User

5. Add a new Insbridge user. Enter user name and password information. Uncheck User must

change password at next logon. Check User cannot change password and Password never
expires.

6. Click Create.

Close the Add New User screen and select the Insbridge user. Right click and select Properties.

The Insbridge User should be assigned to the local Users group and have the same permissions
as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user
cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.
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Figure 2 Adding User information

9. Click OK. Please keep the Insbridge user information close at hand. You will need it for the
installation.

NOTE: You also can create the Insbridge User from within the install. If you create an Insbridge user from
the install, you may not be able to set the permissions you need. Please be sure to verify the
proper permissions are in place before continuing.

To Create a New User in Windows 2003:

1. Right click the My Computer icon on the desktop and select Manage.
2. Under System Tools, Select Local Users and Groups.
3. Select Users and right click.

4. Select New User.
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5. Add a new Insbridge user. Enter user name and password information. Uncheck User must
change password at next logon. Check User cannot change password and Password never
expires.

6. Click Create.

New User E]E|

Uszer name: Insbridge

Full name: IBRL Uszer
Description: [BRU User
Pazswaord: TIIIIIY
LConfirm password: L L LT

Uzer cannot change password
FPazzword nesver expires
[ ] &ccount iz dizabled

Create J [ Cloze

Figure 3 Adding User information

7. Close the Add New User screen and select the Insbridge user. Right click and select Properties.

8. The Insbridge User should be assigned to the local Users group and have the same permissions
as the internet guest account.

Ideally, the Insbridge user should be added to the local Administrators group. If the Insbridge user

cannot be a part of the local administrators groups, please make sure that the Insbridge user has
permissions on the Insbridge Messaging Service and the Insbridge Task Manager Service.

9. Click OK. You can close out computer management. Please keep this information close at hand.
You will need it for the installation

Insbridge User Password

The password can be set to any password that meets your company standards. The IBRU administrator
must make note of the password for future configuration.

For ease of maintenance, the IBRU user should not have to change the password and the password
should never expire.
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The installation will automatically apply the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This will
recreate the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password. Be aware that re-installing the application will also reset security settings in IBFA
as well.
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STEP 2: WINDOWS 2008 PERMISSIONS

Windows 2008 requires certain permissions be in place prior to running the install.

e For Windows 2008 Server — IIS 6 Metabase Compatibility

e For Windows 2008 Server — Web Server (IIS) — Static Content is required

e For Windows 2008 Server — WCF http activation needs to be enabled

e For Windows 2008 Server — The ASP.NET roll must be installed

NOTE: If you are running Windows 2003, you will not need to set these permissions.

E: Server Manager

File Action View Help

[_100x]

&= 2z H

Sk Server Manager (PLQATB1S)

i.: Roles

7| Features
F Diagnostics
E L!; Configuration
5 storage

2R NE e

§ View the health of the roles installed on your server and add or remove roles and features.

~) Web Sarver (115) Web Server (I15) Help Al

Provides a reliable, manageable, and scalable Web application infrastructure.

~! Role Status Go to Web Server (IIS)

Messages: None
System Services: 3 Running, 1 Stopped
Events: None in the last 24 hours

~! Role Services: 13 installed _E_ﬁﬁ Add Role Services
R [ Stats T &= Remove Role Services
&. Web Server Installed
&. Common HTTP Features Installed L
FN Static Content Installed
&. Default Document Installed
Directory Browsing Not installed
HTTP Errors Not installed
HTTP Redirection Not installed
&. Application Development Installed
L ASP.NET Installed
L \NET Exctensibility Installed
ASP Not installed
CGI Not installed
b ISAPI Extensions Installed
L ISAPI Filters Installed
Server Side Indudes Not installed
Health and Diagnostics Not installed
HTTD | Annina Mt inetallad ;I

%::: Last Refresh: 5/25/2011 2:09:41PM  Configure refresh

Figure 4 Windows 2008 Permissions

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 18



To Add a Role:

1. Start=> Administrative Tools—> Server Manager—> Roles> Web Server (11S)-> Add Role Services.

E: Server Manager

File  Acton View Help
ke A alal

& severvarager poatsns) | [F
i.! Roles - —7  —47#b b5 m%Hin i —02D—762>—/7#7"—"
ﬁ;j Features

f‘- Diagnostics { 4. View the health of the roles installed on your server and add or remaove roles and features.
i Configuration b
22 Storage —

Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Mot installed
Client Certificate Mapping Authentication Mot installed
115 Client Certificate Mapping Authentication Mot installed
URL Authorization Mot installed
&. Request Filtering Installed
IP and Domain Restrictions Not installed
Performance Mot installed
Static Content Compression Mot installed
Dynamic Content Compression Mot installed
&. Management Tools Installed
&. 115 Management Console Installed
II5 Management Scripts and Tools Mot installed
Management Service Mot installed
&. 115 & Management Compatibility Installed
&. 115 & Metabase Compatibility Installed
115 6 WMI Compatibility Mot installed
115 6 Scripting Tools Mot installed
115 & Management Console Mot installed
FTP Publishing Service Mot installed
FTP Server Mot installed
FTP Management Console Mot installed
Description:

1156 Management Compatibility provides forward compatibility for
your applications and scripts that use the two IIS APIs, Admin Base
Object (ABO) and Active Directory Service Interface (ADSI). You can
use existing II5 6 scripts to manage the I1S 7 Web server.

Figure 5 Adding 1IS 6 Metabase Compatibility

2. Install IS 6 Metabase Compatibility.

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.
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STEP 3. MICROSOFT SQL SERVER

For the Insbridge 4.6 release:

e« The IBSR database has been tested and certified on MS SQL Server 2008 SP/1 on MS Windows
2008 64-hit.

Microsoft SQL Server should not be installed on the same machine where the Insbridge web applications
reside. The SQL Server should reside on a separate host from the IBRU web front end with a properly
configured network connection from the web server front end to SQL Server. Testing can be performed
by using the Data Sources application in Administrative Tools to make a default connection to the
database server.

NOTE: All these settings are available during installation of SQL Server or by using SQL Server
Enterprise Manager, and right clicking the server and selecting properties.

If any of these settings conflict with existing application’s databases residing on the SQL Server,
then a separate instance is required.

Depending on the load expected, the databases can be placed on a separate SQL Server machines that
can either be independent or shared as long as the following conditions are met.

e Server Authentication: Should be set to SQL Server and Windows Authentication mode.

e Collation and Sort Order: Currently supported is the default SQL Server collation using
SQL_Latinl_General_CP1_CI_AS and sort order plus case sensitivity using Latin1_General_BIN
as the server collation. The security database (IB_CLIENT) supports the default SQL Server
collation using SQL_Latinl_General_CP1_CIl_AS. The RateManager and SoftRater databases
can use either case sensitive or non-case sensitive. Please check with Oracle Insurance for any
guestions regarding database server sort orders or collations.

NOTE: For SQL Server, please make sure the SQL Server Client is installed.
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DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the IBRU databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Rating and Underwriting System will fail. An experienced database administrator’'s expertise is
highly recommended before making any security changes.

Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have a database owner (db_owner) role.
db_owner access is needed to execute the Insbridge stored procedures and have full access to the
Insbridge schema. Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, manual steps will

need to be performed to update the databases. If disk admin permissions are not allowed, backups will
have to be done outside of RateManager.
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Chapter 3

FuLL RATEMANAGER INSTALLATION

This installation will install RateManager and the Insbridge Framework Administrator (IBFA). This is for a

Windows only environment, using a SQL Server database.

Before installing, please verify that the system requirements
are in place. Development
Rating and_ Rules
The installation should be performed in the following order: futhering
1. Install the IBRU application. INSTALL:
2. Assigning Insbridge access to the Registry. =4
o o . QBI Publisher
3. Assigning permissions to the Insbridge User for the —
Windows Temp Folder. This is necessary for MSMQ. SUBSCRIBER
For Windows 2008, you also will need to assign Mustbe the same
permissions to the Application Pool Identity.
4. Assigning permissions to the Insbridge User for the S
Insbridge Folder
Contro_ller
5. Creation of the IBRU databases is next. There are two e
databases that must be in place.
a. IB_Client CREATE:
b' I BRM Enwlzgiirrc?elnts:
6. Enter IBFA and Configure: RM — 1o handle
— testing/rating.
a. Create your subscriber. % QA SR - This
. =] environmant
b. Add database connections. - contains the ful
= packages to ba
c. Create your logical environments. © et
Verifying Component Services. 7}
=
FOR WIN 2008 ONLY. Allowing for WCF Activation. CIL PURPOSE of this Physical
. n Environment
9. Install OBI Publisher. I - _
£ Thus_anwl;o'nrtl_ﬂant is f0'|' the
10. Start Insbridge Message Service. = creation ofrafing programs
. ‘g This environment also holds the
11. Login to RateManager and perform IBRU database 5 security Informeation,
updates. N -ommmmTmmmmmmmmseeseeee s
12. Create Backup of Registry Key.
IE_CLIENT
SECurity
For a Windows 2008 Server installation, you must run as |2 Restore
Administrator. B | Server
3 e
g IBRM.SDB
holds Rating &
Rules
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STEP 1 — INSTALL INSBRIDGE RATING AND UNDERWRITING

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance — Insbridge Rating and
Underwriting file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen will be
displayed.

i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M =] |

4  Oracle Insurance Insbridge Rating and Underwriting

[t iz gtrongly recommended that vou exit all Windows programs before running this setup progran.

Click Cancel to quit the setup program, then cloze any programs you have running,  Click Hest to
continue the installation,

wARMIMG: Thiz program is protected by copyright law and intermational treaties.

IInauthorized reproduction or digtribution of this program, or ang partion of i, may result in severe civi
and criminal penalties, and will be prozecuted to the masimum exstent pozsible under law.

ORACLE

INSURANCE

Cancel |

Figure 6 Installing Insbridge

3. Click Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M =] |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The “Wize [nstallation ‘Wizard will install the files for Oracle Insurance - Inzbridge A ating
and ndenwriting in the following falder.

T inztall inta a different falder, chick the Browse button, and select another folder.

Yau can chaose not ta inztall Oracle Insurance - Inzbridae Bating and Undenwriting by
clicking Cancel to exit the Wize [nztallation 'Wizard.

Destination Falder

:4%Frogram FileshOracles GEU nsbridgeh Browse... |

Wize Inztallation Wizard [R]

< Back I Mest » I Cancel

Figure 7 Entering the Destination Folder for Insbridge

Choose the location where the Insbridge installation will be installed. A default installation folder will
be created for all new installs. This will be the location for all future installations for Insbridge
applications. Select Browse if you want to install in a different location. After selecting a location, click
Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M =] |

Logon Information DRACL,E

The fallovaing logon information = uged by Insbndge. INSURANCE

Specify a uzer account bo be uzed by the application, either for running a service or for
logainig anta ather servers. Uze the Browse buttan ta chooze wsers from vaur netwark.
For domainz, user names must be in the format of DORMAINY ) zerM ame.

Uzer Marne: |Insl:uriu:|ge Browse... |

Pazzward: | [[[]I1]

Create Hew User...

Wize Inztallation Wizard [R]

Cancel |

Figure 8 Logon Information

5. Enter the Insbridge user name and password for the local user account you set up earlier. The
logon information screen will be displayed. You must specify a user account to be used by the
application. Please use the Insbridge user account that you set up on page 13.

NOTE: You can Create a New user at this point, if needed. Click the Create New User button to be
placed on New User screen to setup an Insbridge user.

6. Click Next to continue.
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M =] |

Select Features DRACI_E

Fleaze select which features pou would ke to ingtall. INSURANCE

Feature Description:

Oracle Inzurance Inzbridge R ating and
IIndenariting iz a Web-bazed rating, rules, and
e (=01 = | Oracle Bl Publizher Reports undenyuriting spstem.

Thiz feature will be inztalled on the local hard
drive.

Thiz feature requires OK.B an yaur hard drive. [t
haz £ of 2 subfeatures zelected. The zubfeat...

Current location;
C:APROGRAR FILESYORACLEMGELSINSERIDGE®,

Wize Inztallation Wizard [R]

Diigk Cozt Beszet < Back I Mest » I Cancel

Figure 9 Selecting Features for Installation

7. The next screen will list the applications to be installed. To expand the options and view details, click
on the downward arrow. All features are checked for installation. RateManager is the only one that

you will be allowed to not install. Click Next to continue.
Options are:

e Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

o RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

- This option does not install the OBI Publisher. Only the templates required by the IBRU

application will be installed on local hard drive.
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i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M= B |

Ready to Install the Application ORACLE

Click Mext to begin installation,
ik Mewt to begin installation INSURANCE

Click the Back button ta reenter the installation infarmation or click Cancel b exit
the wizard.

Wize |natallation YWizard [R]

Figure 10 Ready to Install

8. A Ready to Install screen will be displayed. If you are ready, click Next. Otherwise click Back to check
the options you want to install.

i'e!:l‘ Oracle Insurance - Insbridge Rating and Underwriting Setup

Updating System ORACLE

The features you selected are currently being installed.

INSURANCE

Stopping services...

Service: Inzbridge Mezsagelueus Service

Time remaining: 21 zeconds

Wize |natallation YWizard [R]

Figure 11 Installation Progress
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.00 Setup M =] |

Readme Information DRACLE

Inzbridge haz been succezsfully inztalled. INSURANCE

Microsoft Windows 2003/2008 Server o
A full installation of Microsoft Server 200372008 is required. The following
configuration assumes that the administrator of the server to be generally
familiar with managing a YWindows server.

Internet Information Services (l15)

The InsBridge Rating and Underwriting Systern is a web based application and
requires 115 to be installed before installation to facilitate the default web virtual
directories creations.

The subcomponents of 15 needed by IBREL:

. Comrmon Files
. Docurmentation
. Internet Information Services Snap-ln |

Wize Inztallation Wizard®

Cancel |

Figure 12 Install ReadMe Screen

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 2 — CONFIGURING REGISTRY ACCESS

NOTE: If you use Registry Editor incorrectly, you may cause serious problems to the operating system.
These problems may require you to reinstall your operating system. Insbridge cannot guarantee
that you can solve problems that result from using Registry Editor incorrectly.

By default, only administrative and power user accounts have full permissions over this key. The
insbridge user must also be given full control over the following registry key:

HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
Assigning Permissions for the Registry Access

1. Select Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. Browse to HKEY_LOCAL_MACHINE. Select SOFTWARE->Insbridge.

&' Registry Editor
File Edit Wiew Favorites Help

=M Computer Marne Type | Drata
. HKEY_CLASSES_ROOT ab]{Default) REG_SZ {value not set)
. HEEY_CURREMT _USER
HEEY_LOCAL_MACHIME
. BCDOO000000
. COMPOMENTS
. HARDWARE
. 5AM
""" . SECURITY
=~ | SOFTWARE
- Classes
- Clients
- L Ghy
- Hewlett-Packard

Expand
Mew 3
Find...

Delete
Rename

Export
""" 4 Permissions. ..
..... | Copy Key Mame
----- . Registeredpplications
- L wWOWe432Node

< |y SYSTEM

[l | HKEY_USERS

[ || HKEY_CURRENT_CONFIG

[l
e

|Computer\HKEY_LOCAL_MACHINEYSOFTWARE Insbridge 4

Figure 13 Configure Registry Access Windows Server
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4. Right click and select Permissions.
5. Scroll through the users. Select the Insbridge user.

6. Verify that the Insbridge user has Full Control.

7. If the Insbridge user does have Full Control, cancel out of the registry and continue with the

installation.

8. If the Insbridge user does not have Full Control, change permissions to allow for Full Control.

Save your entry and close out the registry. Continue with the installation.

9. If the Insbridge user is not listed, follow the step to add the Insbridge user.

Adding the Insbridge User:

1. From the Permissions screen, click Add.

2. Onthe Select Users or Groups popup, you can leave the defaults for the Object Types and

Locations or enter the values you require.

Select Users or Groups ﬂ

Select thiz object type:

ILlsers, Groupz, or Built-in securnity principals Object Topes...

Frarmn thiz location:
IWIN;-‘-.F'F'EIEH Locations...

Enter the object names to zelect [examples]:
Inzbridge] Check Mames

Advanced... | k. I Cancel

P

Figure 14 Entering the User

3. Enterin the user name (insbridge) and click Check Names. If the user name is found, it will be
listed. If the name is not found, an error screen will be displayed. Cancel out and to return to the
Select Users or Groups popup. Click Advanced to search. To search the directory, click Find Now
and scroll through the list until you find the user name you need. If the user name is not listed,

return to User Accounts and verify the user name was created.

4. Once the name is listed, click OK.
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. Permissions for Insbridge |
SecLrity |

GTCILIFI ar Uzer hames::

‘ﬂ" CREATOR O'WHER

42, 5YSTEM

l Inzbridge [\ O0T Y nsbridge]
WJ.ﬂ.dministratDrs [ 007 A dministrators]
52 Users [WINDOTW ) sers)

Add... | Remove |
Permizzians for Inzbridae Al Deny
Full Cortral O
Read O
Special permiszions O O

For special permizzions or advanced settings, Advanced |
click Advanced.

Learn about access caontral and permigsions

] I Cancel | Apply |

Figure 15 Applying Permissions

On the Permissions screen, make sure the insbridge user is highlighted and check to give Full
Control to the entire Insbridge key.

Click OK.

Close the registry and continue with the install.
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STEP 3 — ASSIGNING PERMISSIONS — WINDOWS TEMP FOLDER

Permissions must be assigned for the Windows Temp Folder for MSMQ and for Windows 2008, the
application pool default identity. Prior to assigning permissions, please verify the default application pool
identity.

Identifying the Application Pool Default Identity:

Open IIS. Start->Administrative Tools=>1IS Manager.

Expand the server and select Application Pools.

Select the DefaultAppPool.

Right click and select Advanced Settings.

Take note of the Identity under Process Model. This user will need to be added to the Windows
Temp file. In this example, the Identity is NetworkService.

arwNE

"E Internet Information Services (IIS) Manager
@ G" [3 » WINSRPOOL »  Application Pools

File  View Help

Comnections L
I Q‘é’ Application Pools
gj Start Page B This page lets you vi .
= é__gm:g;g;ﬂl:l:j:umhdm.m applications, and pro Advanced Settings K E
(8] Sites Filter: B (General) =
E@ Delfault Web Site ﬁ NET Framewark Version vZ.0
__| aspnet_dient m Enable 32-Bit Applications False
.;: ::::I ,@Defaulb\ppPool Managed Pipeline Mode Integrated
X hame [
».? RM Queue Length 1000
Start Automatically True
E cPU
Limit 0
Limit Action MoAction
Limit Interval (minutes) 5
Processor Affinity Enabled False —
Processor Affinity Mask 4294967295
Process Model
Identity NetworkService
Idle Time-out {minutes) 20
Load User Profile False
Maximum Worker Processes 1
Ping Enabled True
Ping Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) a0
Starhn Time Limit {zernnds) an hat
Name
[name] The application pool name is the unigue identifier for the application poal.
OK Cancel |
VA

Figure 16 Verifying Application Pool Settings
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6. Click OK to close the Advanced Settings screen.
7. Close IIS. No more information is needed from the Application Pool.

NOTE: This step is for Windows 2008 only.

Assigning Permissions in the Windows Temp Directory:

1. Open Documents. Find the WINDOWS folder, most likely on your C drive.
2. Right click the Windows—>Temp folder.

‘i Temp

=1 B3

ATL

(;( }v | = Computer = Local Disk (C:) = Windows « Temp - v lmJ ISearch l‘_ﬂj
File Edit Wiew Tools Help
Organize v 55 Miews ¥ (7]
Eavarits Links Mame - |v| Diate modified |v| Type |v| Size |v| Tags |v|
TestEngDated 218/2010 12:54 PM  File Folder
[/ pocuments || DMIZFE.tmp 2j5{2010 1030 &M TMP File 0 KE
‘E Pictures || DMIFCSG.tmp 218/2010 10:30 AM - TMP File OkB
"ﬂﬂ Music || Frksgrafile0, sqm 71212010 12:58,., SCQMFile 1KB
More s || Fksgmfilenl.sgm 7119)2010 1:1& PM SQM File 1KE
|| Fwksgafile0Z.sgm 7126/2010 1:34 PM SCQM File 1KB
Folders w | fmtsgmfile03.sqm 8122010 1:47 PM SQM File 1KE
|| Fratsgmfile04,sgm 8/9/2010 1:53PM  SM File 1KE
Tasks [ || Fesksqmile0S, sqm 8(16/2010 1:54PM  SOM File 1KE
M || Fratsgmfile0s, sgm 8/23/20102:02 PM SM File 1KE
Zpant || Fesksqmile07. sqm 8/30/2010 2:07PM  SOM File 1KE
Explare || Feksgmfile0d.sqm 4/12/2010 3:23PM  SQM File 1KE
Cpen J || Fratsgmfile0s. sqm 4119/20103:25 PM  5CQM File 1KE
|| Fksgfile10.sgm 4/26/2010 3:41 PM SQM File 1KE
0o || Fwstsgmfile11.sgm Ef6/2010 ::38 AM  SQM File 1KB
L_J, LD\ Y Scan For threats., . || Fwaksgmfilel 2.sgm 5i13/2010 %50 AM  SQM File 1KB
2 & Metwo || Fratsgfilel3.sgm Sf24)201011:12... SQM File 1KE
i gad  PEStore previous versions || Fsksgmile14.5qm 5/31/2010 11:27... SOMFile 1KE
M| aMs| send To || Fratsgmfilel5,sgm 6172010 11:42 AM  SQM File 1KE
LS - _Fwtsqu?lels.sqm 6f14j2010 11558... SQM F?Ie 1KE
M aps Cony _Ewtsquflel?.sqm 6/21)2010 12:06,.. SQM F!|B 1KE
W fMs || Fwksgfileld.sgm BfZ8iz01012:21... 5GM File 1KE
l- AREl  Delets || Fksgmfile19.5gm . 7152010 12:37 PM SQM File 1KE
M| 45c|  Rename || F¥STIFFDebuglogFile  4/29/20109:35 AM  Text Document OKE
L
e
I

ATL

Properkies

M|

Figure 17 Assigning Permissions for the Insbridge User on Windows Temp

o0k w

Select Properties. The Temp Properties screen will open.
Select the Security tab.

Click Edit.
On the Permissions for Temp screen, select the Insbridge user and click Add. If the Insbridge

user is not found, cancel out and return to the Local Users and Groups area in Server Manager
and verify the Insbridge user was created.
7. Update the permissions. The Insbridge user requires Full Control.
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8.
9.

10.
11.

l Temp Properties |
. Generall Sharing  Security I Previouz \:"ersiansl Eustn:-mizel

Object name: G \WindowshT emp

GTDUFI ar Wser name:s:

Inzbridge [\ O0T Y nsbridge]
52 Adminiztrators [WINO01 WAdministrators)
52 U zers [WINDOTA 2erg)

\1 IS SRS DSOS SRS
L

i

T o change permiszions, click Edit. I« Edit...
Permizzionz for Inzbridge Alloy Deny

Full control vy -

b odify _

Read & execute wy

Lizt falder contents o

Read v

Wite o ﬂ
For special permizzions or advanced settings, Advanced |

click Advanced.

L earn about access contral and permigsions

] I Cancel | Apply |

Figure 18 Temp File Properties

Next add the Application Pool identity.

Update the permissions. The Application Pool identity requires the default permissions plus
WRITE.

Click OK to close the Permissions for Temp screen.

Click OK to close the Temp Properties screen.

For Windows 2003:

ook wbdpE

Open Windows Explorer. Find the WINDOWS folder, most likely on your C drive.

Right click the Windows->Temp folder.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users or Groups popup, enter in the user name (insbridge) and click Check
Names. If the user name is found, it will be listed. If the name is not found, an error screen will be
displayed. Cancel out and return to the Select Users or Groups popup. Click Advanced to search.
To search the directory, click Find Now and scroll through the list until you find the user name you
need. If the user name is not listed, return to User Accounts and verify the user name was
created.

Once the name is listed, click OK.
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8. On the Temp Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.
9. Click OK.
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STEP 4 — ASSIGNING PERMISSIONS — INSBRIDGE FOLDER

Assigning Permissions for an Insbridge Folder Location

1. Open Documents. Locate the INSBRIDGE folder, most often the Insbridge folder is located at:
C:\Program Files\Oracle\IGBU\Insbridge.
2. Right click the Insbridge folder.

ﬂ Insbridge M=l E3
‘;\1 )v | - Local Disk (i) - Program Files - Oracle - IGBU ~ Insbridge - v i3 ISearch (2]
File Edit Wiew Tools Help
Organize S Views _6
Favorite Links Mame = | -| Date modified |« Type | -| size |- Tags |-l
COM+ 2/15/2011 4:31 PM  File Folder
[ Documerts Framework 4/2942010 8154 AM  File Folder
-"E Pictures Expand 211502011 4:31 PM  File Folder
-‘ﬂ'l Music o tRater 4/29/2010 5:54 AM  File Folder
Mare e bs 412902010 5:54 4M  File Folder
Faolders iz
inetpubs K 5can for threats. ..
Insbridge

Restore previous wersions

Perflogs

= | Program Files Send To b

Common Fils| - ¢
Hyper-¥ Copy
Internet Exp
McAfee Delete
M3ELild Renams
= Cracle
= IGBU e
rsorcobgr e |
Packaged Programs
Reference Assemblias
windows Calendar
Windows Defender
windows Mail
Windows Media Player
Windows NT
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Figure 19 Assigning Permissions for the Insbridge User on Insbridge

3. Select Properties. The INSBRIDGE Properties screen will open
4. Select the Security tab.
5. Click Edit.
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Figure 20 Insbridge Folder Properties

On the Permissions for INSBRIDGE screen, select the Insbridge user and click Add. If the
Insbridge user is not found, cancel out and return to the Local Users and Groups area in Server
Manager and verify the Insbridge user was created.

Update the permissions. The Insbridge user requires Full Control.

Click OK to close the Permissions for INSBRIDGE screen.

Click OK to close the Temp Properties screen.

For Windows 2003:

=

oukhwnN

Open Windows Explorer. Locate the INSBRIDGE folder, most often the Insbridge folder is located
at: C:\Program Files\Oracle\IGBU\Insbridge.

Right click the Insbridge folder.

Select Properties.

Change to the Security tab.

Click Add.

On the Select Users or Groups popup, enter in the user name (insbridge) and click Check
Names. If the user name is found, it will be listed. If the name is not found, an error screen will be
displayed. Cancel out and return to the Select Users or Groups popup. Click Advanced to
search. To search the directory, click Find Now and scroll through the list until you find the user
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name you need. If the user name is not listed, return to User Accounts and verify the user name
was created.

Once the name is listed, click OK.

On the Insbridge Properties screen, make sure the insbridge user is highlighted and check to give
Full Control.

Click OK. You can close out Windows Explorer.
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STEP 5 - RESTORING IBRU DATABASES IN SQL SERVER

Because many corporate environments have a separation between the system administrator and the
database administrator, the following process may require both administrators’ access and permissions.
Make sure you have a SQL Server account called ibru.

NOTE: If you do not have database permissions, you will not be able to perform the following database
procedures.

NOTE: If you are unsure how to perform a database restore, please consult with your database
administrator.

Currently supported is the default SQL Server collation using SQL_Latinl_General_CP1_CI_AS and sort
order plus case sensitivity using Latin1_General_BIN as the server collation. The security database
(IB_CLIENT) supports the default SQL Server collation using SQL_Latin1_General_CP1_CI_AS. The
RateManager and SoftRater databases can use either case sensitive or non-case sensitive. Please check
with Oracle Insurance for any questions regarding database server sort orders or collations.

1. Located in the Insbridge Installation Directory:

¢ SQL Server
- RateManager — IBRM
o0 Latinl_General_BIN
= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl General CP1 CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security —IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak

2. Select the RateManager backup file you want to use, case sensitive or non-case sensitive. The
Security — IB_CLIENT file is only non-case sensitive.

3. Copy both files to an appropriate database folder on the machine where SQL Server is installed.
For example, [Drive]:\Program Files\Insbridge\Databases. If you are unsure of a location, please
consult with your database administrator.

4. Rename files. It is not required but it is strongly suggested that the database file names be
changed from TEMPLATE to something that defines the databases more accurately. At a
minimum, it is recommended that you remove “_ TEMPLATE” from the name. You can change the
names after they have been restored also.

5. Open the SQL Server Management Studio either on the server or remotely using either an
administrative account with sa privileges or as the sa account.

NOTE: If you do not have SQL Server Management Studio, check to see that the SQL Server Client has
been installed. For a SQL Server install, you must have the SQL Server Client installed.
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Figure 21 Restoring a Database to SQL Server

6. Go to Databases.

rosoft SOL Server Management Studio - [Object Explorer Details]

'-_‘53 Ele Edit ¥ew Tools Window Community Help

Dnewquey | |ER M |3 | St H @ B EHBE S,

) -}
@ e T EE

Er
Connect * _ﬂg mT @
E |4 Southern (SOL Server 9.0.4035 - sa) id Databases
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Figure 22 Right Click to Restore Database
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7. Right click on Databases.

8. Select Restore Database... A separate screen will be displayed.

Ej' O ptiors

Server
Wi MAPODINSOL

Connection:
2a

2{ View connection properties

B Restore Database - IB_CLIENT

;S Scrpt - m Help

=] B3

Deztination for restore

Select ar type the name of a new or existing databaze for your restore operation.

To database: fIE_CLIENT |
To a paint ik tirme: IMDst recent pozsible |

Source far restare

Specify the sowrce and location of backup sets to restare.

 From database: I j
& From device: IE:'\F‘ngram Files\Microsoft SOL Server\MSSOL 1455 |
Select the backup sets to restore:
Restore | I arne I Campatemt | T_I,Ipel Server I Databaze | Positicn
v [atabase Full  PWwWIDEWODOOT IB_CLIENT_TEMPLATE 1
< | L]

Figure 23 Restoring a Database

9. Enter your IB_CLIENT database name in To Database:.

10. Select From Device. Click ... to browse to the location where the database files were placed in

step 3.

11. Select your database IB_CLIENT_ xxxx.BAK, where xxxx equals the renamed file from step 4.

12. Click OK. Your database will be populated.

13. Verify your information. Check the Restore box.

14. Click OK.
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15.

16.

17.

If the database was restored successfully, it will be displayed in the database folder. If not, please
correct any errors and try again.

Repeat for the RateManager database and any SoftRater database.

Once the databases are restored to SQL Server, you will need to create or assign a SQL Server
user account for the application. This user will be used for the connection to the databases when
setting up the connections from the Insbridge Framework Administrator. Make note of the account
you want to use. This information will be entered into the Insbridge Framework Administrator.

If backups are to be allowed from the RateManager application (see page 38 for more details),
then the ibru SQL server user account must have the Disk Administrators SQL Server role.

For ease of administration, the database user should have db_owner permissions on the
IBRM_xxxx, and IB_CLIENT databases.
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STEP 6 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

Open an Internet Explorer web browser either remotely on the local IBRU web server and browse to the
following location, replacing SERVERNAME with the actual server name:

http://SERVERNAME/ibfa/

ff Framework Administrator - Windows Internet Explorer El@l@l

ey ey

= ] httpfiLocahostibFaidsfaut.2spx| [ 42| x

i Fle Edt Wew Favortes Tools Help

= R »
W I@FramewurkAdmlmstratnr ] } v B o~ [bpage - ) Took -
ORACLE Insurance Insbridge Framework Administrator Version 04.06.00 (x86)
&3] ~
=8> | Insbridge C ion File [C:\PROGRAM FILES\ORACLE\IGBU\INSBRIDGE\FRAMEWORK\3.5.0\Insbridge.Xml]
3 SoftRater ‘The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge.xmi) found on your
network, Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ softData that reside on the same Framework Server share the same file.
|+E3 services
Logs Change Config File location: Browse... | Update
Security
‘2 Softlibraries Add Subscriber
i) Help The subscriber identigffr is an unique number that you wauld like to represent your company. Please consult with an
Wgyricige suppogjg#fhresentative if you have any questions.

@ Mo Subscribers Faund.

Add Database Connection

Create or edit database connection, This database connection can be global to the Insbridge Framework or unique to the
Subscriber,

Click on the name of the connection to edit.

€2 Global

# Mo Connections found.

|

Copyright © 2000, 2009, Oracle and/or its affiiates. All rights reserved.

Done & Lacal intranet F100% v

Figure 24 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Insbridge directory. Regedt->Insbridge Directory-> Security.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
7.0 or 8.0 (32-bit). Release 4.6 does not support Internet Explorer 8.0 (64-bit).
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There are five steps that will need to be done in IBFA:

Step 1 — Creating a New Subscriber

Step 2 — Adding a Global Database Connection

Step 3 — Adding a Security Database Connection
Step 4 — Adding an RM security Database Connection

Step 5 — Creating a RateManager Environment

Step 1 — Creating a New Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1.

2.

Click on Add Subscriber on the Main IBFA screen. A separate screen will be displayed.
Enter the ID, Name and Description for your subscriber.

When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

2 Subscriber -- Webpage Dialog @

Subscriber
Flease enterfupdate your Insbridge Customer information below,

1D: 3659
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

Figure 25 Enter ID
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NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 3 or 4 digit number and must unique for each subscriber. For
example, if you have an instance of IBFA on machine A, you can create a subscriber with an 1D
of 100. On machine A, if you create another subscriber, you must give that subscriber a different
ID number, say 200. If you also have an instance of IBFA on a different machine, B for example,
you should duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

Troubleshooting Subscriber Entries:

If you receive an error message or have difficulty creating a subscriber, you may need to add the
Insbridge user to the Windows Machine Keys.

1. Goto C:\Documents and Settings\All Users\Application Data\Microsoft\Crypto\RSA\MachineKeys.
2. Right click and select Sharing and Security. Select the Security tab.

3. Add the Insbridge user.

Add Database Connections:

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the IBRU system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.

Step 2 — Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.
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1. From the Insbridge page, click the Add Database Connection link. This will open the Connection
screen.

/A Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber,

Subscriber: Global w
Mame: Controller
SErver: LocalHost Test Connection...

Server Type: | SQLServer W

Catalog: IE_CLIENT

Catalog Type: | Other w
Query Buffer:

Tablespace:

Schema:

ser: BE]

Password: TIITIIL

Save Cancel

Figure 26 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The

controller and security databases will both be type OTHER. The rm database will be type
RateManager.
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8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

/2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.

Subscriber: | Glabal "

Mame: |

Server: Test Connection...

Server Type: | SQLServer W |

Catalog:

Catalog Type: | Other w |

Query Buffer:
Tablespace:
Schema:
User:

Password:

Save Cancel

Figure 27 Adding a Database Connection

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.

Step 3 — Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.
2. Select Your Subscriber. The security database is unique to the subscriber.

3. Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.
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4. The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.

7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

A Connection -- Webpage Dialog @

Connection
Database connections can be global to the Insbridge Framework ar unigue to the Subscriber.

Subscriber: Alamere Insurance W
Mame: Security
Server: LocalHost Test Connection...

Server Type: | SQLServer b

Catalog: IB_CLIENT

Catalog Type: | Other A
Query Buffer:

Tablespace:

Schema:

User: ]

Password: senenene

Save Cancel

Figure 28 Setting up the Security Database Connection
Step 4 — Adding an rm Database Connection:

1. Next, add the rm database. Select the Add Database Connection link again.
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10.

Select Your Subscriber. The rm database is unique to the subscriber.
Enter rm for the Database Name. This cannot be changed once you have saved it.

The Server is the database server name or IP address which ever is resolvable by the IBRU web
server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.

Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

2 Connection -- Webpage Dialog

Connection
Database connections can be global to the Insbridge Framework ar unigue to the Subscriber.

Subscriber: Alamere Insurance W
MName: RM
Server: LocalHost Test Connection...

Server Type: | SQLServer b
Catalog: IBRM

Catalog Type: | RateManager |#

Query Buffer:

Tablespace:

Schema:

User: ]
Password: senenene

Save Cancel

Figure 29 Setting up the RateManager Database Connection
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NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:
e RM —to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.

Step 5 — Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.

1. Browse to SoftRater>Explorer>Subscriber name.

(= Framewaork Administrator (WINAPPOO1) - Windows Internet Explorer,

@.\-:/. ~ | €] httpiiLocathost/1eFajdetault aspd RIS
Fle Edt Vew Favortes Tools Help
5 - »
" e I@Framewurmdmumstratur (WINAPPOD1) [ I PR B - @ - [Shpaoe - ook -
ORACLE msuance Insbridge Framework Administrator Version 04.06.00 (x86)
[x]
Settings
E-C3 Tnsbridge na
S+ SoftRater
Engine
3 Explorer Configuration
Bl
{3 softData
Services
Logs # No environments found.
Seaurity
5 SoftLibraries i .
‘a Line-of-Business Management
@) teb Your rating book of businesses are identified by an id and a description, There is no limit to the number of LOB's (ine-of-
business) that your Explorer can cantain.
ID - DESCRIPTION
# Mo Lines found.
Virtual File Server Manangement
There are times when you must donnload SoftRater packages from different locations. These locations require & domain
name of an ip-address of the particular server.
# No file servers found.
< | & Copyright © 2000,2009, Orade and/or its affiiates. Al rights reserved.
Done %J Local intranst HAOD% v

Figure 30 Create a Rating Environment

2. Click on Add Environment.

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 50



/A Environments -- Webpage Dialog

A SoftRater configuration can support an unlimited number of environments.

Mame: RM_Default

Type: | Dev w

Secure: [

Save Cancel

Figure 31 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your IBRU
system is designed.

There are three types of Logical Environments:

o Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORAC I_E. Insurance Insbridge Framework Administrator

x|
E-[3 Insbridge Settings

EILj SoftRater

L:I Engine

=3 Explarer Add Environment

Add, edit, or remove environments from your Explorer configuration.

-~ SoftData e
i services # BM Default - Development
F-[J Logs # gQualityControl - Quality Assurance
B-C3 Seaurity % SR _RM - Production

Figure 32 Obtaining Environment Information
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Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

2 Framework Administrator (WINAPPDO1) - Windows Internet Explorer

@ :‘/ + ] httpi/lLocalhost/IBFAfdefaut. aspx| DIEES
: Fle Edt Wew Favortes Tools  Help
w o I (& Framework Administrator (WINARPOOL) ]_1 fp - B - & v [hrage v @ Took v
ORACLE nsuance Insbridge Framework Administrator Version 04.06.00 (x86)
£
-0 Tnsbridge Settings
£ softRater
(3 Engine ~
W Corngurtin
e Environments Environment(s) yau may use for development purposes. Selecting an environment below wil denote it as the default.
i~ SoftData
—— Environment: RM_Default ®
[ Logs Test Environment...
Security DB Server: WINAPPOO3
5 Softibraries DB ServerType:
@) Help DB Catalog: BRM_Alamere
DB CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema: b
DB User: s
DB Password: sesreeee
Engine Location: LOCALHOST
Engine EnvDef: Discaver
Environment(s) you may use for quality assurance purposes. Selecting an environment below will denote it as the default.
Environment: QualityControl (@]
Package Location: C:\Insbridge\SRP Test Environment...
DB Server: WINAPPOO3
DB ServerType:
DB Catalog: IBSR_Alamere
DE CatalogType:
DB Query Buffer:
B ~
< | 3 Copyright & 2000,2003, Oracle andjor its affiiates. Al rights reserved.
Done % Lacal intranet H100% <

Figure 33 Editing Environment

10.

11.

The Environment Name will be complete. No changes are needed.
RateManager environments will not have a Package Location. No entry will be allowed.

Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored.

The DB Server Type will be SQL Server.
The DB Catalog is the name of the RateManager database restored in SQL Server.
The DB Catalog Type is RateManager.

DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.
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12.

13.

14.

15.

16.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManger installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManger installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.
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STEP 7 — VERIFYING THE COMPONENT SERVICES

Next, you should verify the component services.

For Windows Server 2008:

1. Click Start>Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

(%) Component Services

o

#. File  Ackion Wiew  MWindow  Help

R
o . —1f - . »
o= | 27| XE ¢ HiE| O]k = -
[_ Console Root ? % ? % Actions
S Clgmponent Services = - COM-+ Applications -
B [ Computers COM+ COM+QC  COM+ Utiities  Insbridge i
B & My Computer Explorer Dead Let... Com+ Ad... More Actions 4

= CoM+ Applications

2 Com+ Explorer a, a_ @
‘A COM+ QC Dead Letter Queue Listener L+

% COM+ Utilities Insbridge Insbridge Syskem
£ Insbridge Com+ Administrator 3.5 Com ... Com+ ... Application
g Insbridge Com+ SoftRater Engine
¢ Insbridge Com+ SoftRater Library
% System application

~| DCOM Carfig

| Rurning Processes

HEMBEH

| Distributed Transaction Coardinataor
@ Event Viewer (Local)
© Services {Local)

Figure 34 Component Services

There should be 3 Insbridge Com+ Applications libraries:

e Insbridge Com+ Administrator 3.5
o Insbridge Com+ SoftRater Engine
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o Insbridge Com+ SoftRater Library

Please note that you will not have to make any changes to any COM+ Application library. The installation
will automatically apply the Insbridge user name and password that you created earlier to the necessary
libraries. If you change the password, you will have to change the password in all three of the Insbridge
Com+ libraries. On each library, right click, select Properties, select the Identity tab, enter in the new
password.

NOTE: If any COM+ library is missing, run the IBRU install again from the msi file and choose uninstall.
Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see if all the
libraries are listed. If they are still not listed, please log a Service Request using My Oracle
Support at https://support.oracle.com/.

For Windows Server 2003

1. Click Start>Administrative Tools>Component Services.
2. Expand the Component Services option under console Root.
3. Expand Computers>My Computer->COM+ Applications.

4. Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.
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STEP 8 — ALLOWING FOR WCF ACTIVATION

FOR WINDOWS SERVER 2008 ONLY. Windows Server 2003 can skip this step.

WCEF Activation is required for web services. RateManager makes call using IBFA web services. If this is
not activated, users will experience errors.

1. Select Start->Administrative Tools—> Server Manager.
2. Select Features Summary. Scroll through the list to verify WCF Activation has been activated.
3. If not, select Add Features. The Add Features Wizard will be displayed.

Add Features Wizard

Select one or more Features to install on this server,
Confirmation Eeatures: Description:

Progress B [¥] MET Framework 3.0 Features (Installed) =| et Sy it cleelinr Lotk fay

—1 {WCF} Activation uses ‘Windows

Results ET Framework 3.0 (Installed) Process Activation Service ko invoke
%P5 Wiewer (Installed) applications remately over the
WCF Activation (Installed) network using protocols such as
|: BitLocker Drive Encrypion HTTP, Message Queuing, TCF, and

named pipes. Consequently,

L BITS Server Extensions applications can start and stop

|: Zonnection Manager Administration Kik dwnamically in respanse ta incaming
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[ remote Differential Compression
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More about Features
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Figure 35 Selecting WCF Activation

4. Select WCF Activation. Click NEXT.
5. Confirm your selection and click INSTALL. The installation will proceed.
6. You can close out when complete.
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STEP 9 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

1. Unzip the OBI_PUBLISHER

# 0Bl Publisher, Setup [EEuE

OBl Publizher N
Release MNokes, (*j

date khe current

cle BI Publisher (Cracle Insurance - Insbridge Install) will u
ko 10.1,3.4.0

Install l [ Cancel

Figure 36 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager in
Windows 2008 or the Services in Windows 2003.
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STEP 10 — STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task Manager is
a task queue that lists the tasks that are scheduled to be performed as well as the last time the task was
run and the status.

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly (process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou =ee this message, vou have not requested a listing from the selected spake client. Clicking
Wiew Messages will provide you with a list view of the first in - first out messages that are waiting to
execute.

Insbridoe Task Manager Stop
The Insbridge Task Manager gives you the ability to execute daily, weekly, hourly, or by the minute.

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 37 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company'’s infrastructure and request the
security team to open the ports used by Publisher.
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STEP 11 — PERFORMING UPDATES IN RATEMANAGER

There are two updates that should be done in RateManager prior to creating user groups and users:
e Step 1 — Running Database Updates

o Step 2 — Updating Preferences

Entering RateManager:

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where the
INSTALLTIONSERVERNAME is the server where RateManager was installed.

This will place you on the RateManager login screen.

1. Tologin for the first time, select your company from the drop down menu. If you have created
only one company, a drop down menu will not be presented.

2. The user name is demo.
3. The password is password.
After running database updates, it is recommended that you update the demo user password.

Users and User Groups can be created after any database updates are run. For more on user
management, please see the RateManager Tools User Guide.

NOTE: If you are having difficulties logging into RateManager, please check the error logs in IBFA.

STEP 1 — RUNNING DATABASE UPDATES

If you log into RateManager and Tools is the only option, you must perform a database update. After you
perform the database updates, to view all menu options, click File>Reload.

/= Oracle Insurance Insbridge RateManager 04.06 - Windows Internet Explorg

ORACLE" Insurance Insbridge RateManager
File | Tools Help

B Database » %  Backups
& Updates

Hom

Figure 38 Tool Mandatory Update
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http://installationservername/RM

NOTE: If you log into RateManager and Tools is the only option, you must perform a database update.

On the DB Updates screen, the current version will be highlighted and the status will be Current. The
updates below the current version will be grayed out. These updates cannot be run again. Current
updates can be re-run if necessary. You will receive an error message if you attempt to run a lower
version update. Any version update above the current version will also be grayed out but will be available
for executing.

New installations may show 04.05.01 as current but still have only the Tools option available. You may
have to run the current script again. To see if you have complete access, click File—>Reload to refresh the

system.

Navigate to the Tools->Database—>Updates.

1. The Updates tab will be displayed. Select the database you want to view from the Show
updates for drop down. The database updates for your selection will be listed. The last column,
the Status column, will show you which update is the Current one installed.

ORACLE Insurance Insbridge RateManager

File Tools Help
Home DB Updates
@ DB Updates

&" Execute Lipdate Script é—*ﬁ Open Lpdate Script E Save Update Script to File E’ﬂ Refresh

Show updates for:| IBRM b
Senpt Release Date Database Status
vO4.06.00.00 3/1/2012 IBRM
vwO4.05.00.00 5/1/2011 IBRM
vwO4.01.00.00 11/15/2010 IBR.M
w4, 00,0.00 3/10/2010 IBRM
v032.13.0.00 12/15/2009 IERM
03.12.0 4/30/2009 IBR.
03.11.0.00 11/z20/2008 IBR
02.10.0.00 8/31/2008 IBR.
03.9.0.00 5,/19/2008 IBR.
03.8.0.00 &/7/2007 IBF.
03.7.0.00 72872006 IBR.

Figure 39 Available Updates

2. There are two ways to execute an update:

a. Directly in RateManager

b. In SQL Server
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Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This will assure that the database showing as Current will have all possible updates.

1. Highlight the update you want to run.

2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.

3. Click OK to run the update or Cancel to return to the previous screen.

4. Run all script in consecutive order until the 04.06.00 script is showing as current.
5. Do this for both the IBRM database and the IB_CLIENT database.

6. Click File>Reload to refresh the system.

2 Confirm Lpdate -- Webpage Dialog @

™ Are you sure you want to replace the
_!‘_/I current database's contents with the
. selected release script on disk?

2 Ok | & cancel |

Figure 40 Updating Scripts in RateManager

In SQL Server

This method should be performed by a database administrator. No warning message will be displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Database names can be found in IBFA->environments. Please see Manual Updates to the IBRU
Database.

STEP 2 — UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the
first time, it is recommended that Preferences be set.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
7.0 or 8.0 (32-bit). Release 4.6 does not support Internet Explorer 8.0 (64-bit).

Oracle Insurance Insbridge Rating and Underwriting Installation Guide Page 61



To Change Settings

1. Select Tools—>Preferences.

Tools Help

Manage Lines

Audik
Migrate Waork, Files

Securiky k

@ & e

Database 3

Change Password

= G

Preferences

2. This will open the Preferences window. Select Web Settings.

a

Preferences
E-Settings
El User =
Web Settings
L-Home Page
=-Administratar )
) Insbridge Configiml Path: [C:\PROGRAM FILES\ORACLE\IGBU\INSERIDGE|\FRAMEWORK,]
- \Web Settings
Mess=ging Server : ||Dca|hcﬁt | {Secure Channel) D
SoftRater Server : |kx,a|hnst | {Secure Channel) |
Backup Share Folder - -
= |C.\jnsbndge\DB_Backup |
Usz Insbridge Com+ N
pirscle
Enforce Release Packaging:
Batch Package Threads:
Minimum Login User ID El
Length:
User must changs D
password: ( )
Show Override Date Mask:
Allcvr Data Type Changs:
Inactive Session Time Cut: El {hrs)
Batch Results with NewdLine:
Online Help Server: ||Dc,a|hcxst | |
My Recent List:
Default Prowy Script T —
— |h1'tp :f (vipadfwpad.dat |
Change Contral: 2
o  Save | & Close |

Figure 41 Preferences Settings
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3. Make any necessary changes. If you do not know all the settings, you can come back and edit lat
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click Save to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if
you have changed the path in IBFA. Please contact Insbridge support for further information. It is strongly
recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, you will use a local path. If the location is not local, you must be a disk admin to
change.

If the database backup location is on a remote server, a share is needed for the backup location. The
Insbridge user must have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If setto True, arelease is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.
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Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or input.
Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting will place
a carriage return between result files. A False setting will result in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
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the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and justification to
any element or program when it is revisioned. If change control is off, the option will not be presented.
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STEP 12 — EXPORT INSBRIDGE REGISTRY KEY FOR BACKUP

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE-Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs). This registry key should be
exported to a text file and stored in a safe location off the server.
This is a safety precaution and will not affect users currently accessing the IBRU system.
If you have to move RM/IBFA to a new machine or in the event of a catastrophic server failure, where the
RM/IBFA server is non-recoverable, the IBRU system will need to be reinstalled. When RM/IBFA is re-
installed on a new server, a new registry key will be created. The new registry key will not match the
registry key associated with any packages that have been created. In order to load packages to the new
server, you will need to restore the previous registry key.
You may also be requested to send to your registry key to support.

1. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

2. Right click and select Export.

3. Select a storage location for the file and Save.

4. Close out of Registry Editor.

At the completion of this step, you may enter RateManager and begin working.
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Chapter 4

MANUAL UPDATES TO THE IBRU DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into
RateManager and run the updates there. If the administrator has DB User privileges and is the
DB Owner of the database as well as the disk administrator, database updates can be done on
the Tools>Database>Updates tab. If these privileges are not in place, an error message will
be displayed. See Step 1 — Running Database Updates for instructions.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that
you enter RateManager and run the 04.00, 04.0, 04.05, and 04.06 update scripts
successively from there. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run
them in sequential order in SQL Server. A DBA or a person with the proper permissions will need
to apply the database updates in SQL Server using Query Analyzer.

1. First, you will need to get the scripts you need from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as
“current”. If you are going from a much lower version of RateManager, you will have to
save multiple files.

3. Click Save Update Script to File. Your computers dialogue box will be displayed. Save
the file to a location of your choice. For IBRM scripts, it is recommended that you rename
the file to usp_IBRM_R(version number).sql. For example the Release 4.6 update would
be: usp_IBRM_R04.06.00.sql. For IB_CLIENT scripts, it is recommended that you
rename the file to usp_IB_CLIENT_RO(version number).sql. For example the Release 4.6
update would be: usp_IB_CLIENT_R04.06.00.sq|.

4. Verify that you have saved all the necessary scripts from “current” to release 04.06.00.
You must save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following
database queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual
database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database.
Open Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program

you want, such as Notepad. Begin with the “current” script. For example, if you are going
from R03.13 to 04.06.00, 3.13 should be “current”. Open 3.13 first.
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Figure 42 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a
new Database Engine Query, File>New->Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower
portion of the screen. You must run the updates in sequential order. Run each update
until you run the 04.06.00 update.

11. When you have finished updating one database, update the remaining database. Make
sure you do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The
status should show current and the full RateManager menu should be displayed. The
updates are now properly applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view.
Click Open Update Script. The update script will be displayed in a separate screen.

21 IBRU : v04.06.00.00 -- Webpage Dialog

acluse

——-5ET THE DATE FORMAT TO AN EXPECTED FORMAT TO SETUFP THE SCHEMAZ INPUIS o
SET DATEFCRMAT mdy
GO

if not exists (select * from INFORMATION SCHEMA.COLUMNS where TRELE NAME
= 'TYPES S5CHEMA' and COLUMN NAME = 'TEMPLATE ID')

ALTER TAELE TYPES SCHEMA ADD TEMPLATE ID INT NULL
ele]

if not exists (zelect * from INFORMATION SCHEMA.COLUMNS where TAELE NAME
= 'TYPES_SCHEMA' and COLUMN NAME = 'TEMPLATE VERSICH')

ALTER TABLE TYPES SCHEMA ADD TEMPLATE VERSION INT NULL
GO

Figure 43 Script Viewer
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Chapter 5
WINDOWS 2003 SETTINGS AND PERMISSION NOTES

Microsoft .NET Framework

It is suggested that the Microsoft .NET Framework version 3.5 be installed prior to the Insbridge
Rating and Underwriting System install. .NET Framework version 3.5 can be obtained from
Microsoft’s website or from using Microsoft's Windows Update.

We also highly recommend installing the .NET Framework after installing IS in order to update all
the web applications to utilize the ASPNET system.

This can be doubled checked by:

Open Internet Service Manager and right click the Default Web Site.
Select Properties.

Select the Home Directory tab.

Click Configuration....

Scroll until you find the ASPNET extensions (.asax, aspx, .asmx, etc.).
To get a detailed look, select an extension and click Edit.

ogkrwnE

Window __Het-

Default Web Site Properties [ 7] %]
B &
ot Serices Directory Security | HTTPHeaders | CustomEmors | AsPhEr |

TWINARROD! {ocal comy WebSte | Performance | ISAPIFiters Home Cirectory Documents |

Application Pocls The content For this resource should come: From:

Weh Sites @ 4 diractory located on this computer

A Default Web Sike
<) \Weh Service Extensior

" & share located on another computer
i redirection to & URL

Logal path:
Appl
I Seript soure
J¥ Read Mappings |0ptmns | Debugaing |
I wirite
I Directorybr ¥ Cache ISAPI extensions
Application sett [ Application extensions
Extens... | Executable Path [werbs |
ashc CH\WINDOWS|Microsoft.NET\Framew..,  GET,HEA.._I
T asme cUWINDOWSIMicrosoft. NET\Framew..,  GET,HEA..
asp CHAWINDOWS|system32\netsr\asp.dl  GET,HEA..
Exente permis aspx GWINDOWS|Microsoft.NET\Framew...  GET,HEA..
axd CHWINDOY s o S

et em | - [Add//Edit Application Extension Mapping
add... £ Executable: IT\Framawnvk\vz‘D‘5D727\aspnet -_isapi.dll Browse.
widcard application map:  EXtension: T

Verbs
© fllverbs

Application nar

 Umitto: | GET,HEA, POST, DEBLIS

Iove Up zve ¥ Seript engine

I~ erify that file exists oK | Cancel

K. [ canel | PR |

;ﬂ'Starl J @B e J @ Download details: ‘NETFH.l ¥ Internet Information SET.Hl ] ﬂ’m
Figure 44 Installing .NET Framework
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If you don’t see any of the ASPNET extensions (.asax, aspx, .asmx, etc.) pointing to
%WINDIR%\Microsoft. NET\Framework\v2.0.50727\aspnet_isapi.dll, then the .NET framework
was probably installed prior to installation of IIS.

To install the ASPNET ISAPI extensions, use the aspnet_regiss.exe located in the
Framework\v2.0.50727 folder. If you want to upgrade all default web applications under IIS to use
the 2.0 framework ASPNET ISAPI, use the following syntax:

C:\WINNT\Microsoft_NET\Framework\v2.0.50727>aspnet_regiis.exe

Install this version of ASP.NET and update script maps at the [IS metabase root and for
all script maps below the root. Existing script maps of lower version are upgraded to this
version.

Please see page 19 in regards to the permissions required by the local ASPNET user account.

Internet Information Services (IIS) 6.0

The Insbridge Rating and Underwriting System is a web based application and requires 1IS to be
installed before the Insbridge Rating and Underwriting System installation to facilitate the default
web virtual directories creations.

The subcomponents of Application Server needed by the Insbridge Rating and Underwriting
System:

Application Server Console

ASP.NET

Enable network COM+ access

Internet Information Services (I1S)

- Common Files (default)

- SMTP Service — Although not required, the SMTP service will allow the Insbridge
Rating and Underwriting System to notify users via email when extended jobs have
been completed. If the SMTP service is located on a corporate network, then the
service must be properly configured for authorization to relay mail internally to a
smart host. Please check with your information services support group for proper
configuration.

- World Wide Web Service

= Active Server Pages
= World Wide Web Service

e Message Queuing

- Active Directory Integration (default)

- Common (default)

After installing IIS and .NET 3.5, Active Server Pages and ASP.NET v2.0.xxxx must be
enabled in order for the IBRU applications to work.

1. Open Internet Information Services (IIS) Manager in the administration tools.

2. Select the Web Service Extensions on the left hand side and make sure they are
Allowed as shown below:
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Figure 45 Enabling Active Server Pages and ASP.NET v2.0

Message Queuing Services

The Insbridge Rating and Underwriting system utilizes the Microsoft Message Queuing Service
(MSMQ) for batching jobs and other types of extended functions. The Microsoft Messaging
Queuing Service can be configured for stand-alone operation without need to access any Active
Directory unless specified by your information support services. The Insbridge Rating and
Underwriting System utilizes by default private message queues that have no need for routing.

Component Services
Eile  Action Wiew Window Help
= | BEEHFRDE 2E > 8w
onsole Root' Services (Local)
Cl Console Root Services {Local)
@ Compaonent Services
< Active pirectory Users and Comp Message Queuing Mame 7 | Description | status | Starbug+ |
H % Even.t Wigwer (Local) %Event Log Enables ev... Started Aukom.
-4y Services (Local) Stop the service @ File Replication Allows files. .. Manua
Restart the service %Help and Support Enables He... Statrted Aukari.
%HTTP S50 This serwic,.,  Started Manua
Description: o %Human Interface 0., Enables ge... Disable
Provides a messaging |nFra_struc_turg and %IIS Admin Service Enables thi,.. Started Aukom.
development koal Far creating distributed i X
messaging applications For Windows- %IMAPI CD-Burning ... Manages C... Disabl
based networks and pragrams. IF this %Indexing Setvice Indexes co... Disable
service is stopped, distributed messages %Intersite Messaging  Enables me... Disable
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Figure 46 Message Queuing Type
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Installing Java Runtime Environment for PDF creation

In order to create reports as PDF files from the RateManager web interface, the Java Runtime
Environment version 1.4 or above must be installed on the web server. The JRE can be
downloaded from the http://java.com/en/download/manual.jsp.

MDAC 2.8

If the Insbridge Rating and Underwriting application is split between a web server and a database
server, then Microsoft's Data access component version 2.8 needs to be installed on the web
front-end server. MDAC version 2.8 is included with Windows Server 2003.

Special Considerations for Windows Server 2003

Microsoft has identified some known issues with Windows Server 2003. Oracle Insurance is
aware that these issues may surface during the installation of Insbridge Rating and Underwriting
System, depending upon your network setup and choice of operating system. Oracle Insurance
offers the following solutions for known issues. Please discuss and involve your System
Administration Group or IT Department prior to making any change. The suggestions listed below
will allow the Insbridge Rating and Underwriting System to function in most environments. Oracle
Insurance makes no claim to knowing what effects these changes may have on other areas of
your network.

Prior to making any changes, please consult with your System Administration Group or IT
Department and Insbridge support.

FIPS Encryption

PROBLEM: A Windows Server 2003 server with an encryption level set to FIPS Compliant will
not allow Remote Assistance connections from a Windows XP box. When you try to connect, you
will receive an error message.

SUGGESTED SOLUTION: Disable the FIPS encryption.

There are two ways to enable the FIPS encryption level. If you have to disable the FIPS
encryption level for Terminal Services, you must do this by using the same method that you
originally used to enable the FIPS encryption level. *

Method 1

To disable the FIPS encryption level by changing the Encryption level setting in the RDP-
Tcp Properties dialog box, follow these steps:

1.Click Start, click Run, type tscc.msc in the Open box, and then click OK.
2.Click Connections, and then double-click RDP-Tcp in the right pane.

* From Microsoft Knowledge Base Article #811770.
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3.1n the Encryption level box, click to select a level of encryption other than FIPS
Compliant.

Note If the Encryption level setting is disabled when you try to change it, the system-wide
setting for System cryptography: Use FIPS compliant algorithms for
encryption, hashing, and signing has been enabled, and you must disable this
system-wide setting by using method 2.

Method 2

To use the Group Policy Object to disable FIPS data encryption system-wide, follow these steps:

1.Click Start, click Run, type gpedit.msc in the Open box, and then click OK.

2.Expand Computer Configuration, expand Windows Settings, expand Security
Settings, expand Local Policies, and then click Security Options.

3.In the right pane, double-click System cryptography: Use FIPS compliant
algorithms for encryption, hashing, and signing, click Disable, and then click
OK.

Note Encryption level settings in Terminal Server are unavailable when FIPS is enabled.

For more information, please visit http://support.microsoft.com/kb/811770.

Distributed Transaction Coordinator (DTC)

PROBLEM: Network DTC access is disabled by default in Windows Server 2003 server. If
network DTC access is not enabled, applications can only use transactions that are located on
the same box. If you want a client to access the server, you will receive an error message.

SUGGESTED SOLUTION: Enable DTC Access.

Please note that you must restart the server. ?

Steps to enable network DTC access

1. Click Start, point to Control Panel, and then click Add or Remove Programs.
2.Click Add/Remove Windows Components.

3. Select Application Server, and then click Details.

4. Select Enable network DTC access, and then click OK.

5. Click Next.

6. Click Finish.

7. Restart the computer.

If you are running Windows Server 2003 SP1, there are additional steps that must be taken.
Please see http://support.microsoft.com/kb/817064/en-us for more information.

2 From Microsoft Knowledge Base Article #817064.
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Chapter 6

CREATING AN INSBRIDGE APPLICATION PooL

Insbridge currently uses the default application pool and requires .NET framework setting of v2.0.
This may present conflicts with other applications in the default pool that require a higher setting.
Or if after a new install you receive an error when accessing IBFA:

CS0016: Could not write to output file
‘c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dll' — 'Access is denied. '
You may need to create a separate Insbridge Application Pool.
There are three steps to creating an Insbridge application pool and then assigning the virtual

directories.

o Step 1: Complete the RateManager installation. Make sure that Static Content is enabled
in the Server Manager Roles.

o Step 2: Create a new Application pool in 1IS called Insbridge. Be sure to configure the
application pool to use the Insbridge user.

o Step 3: Associate the Insbridge application pool with virtual directories IBFA, IBRU, RM

NI E:
File  Action  Wew Help
=% |0
= 5 Roles -
B active Direckory Domain 5e 34
= a‘% web Server (I15) ﬁ# Provides a reliable, manageable, and scalable Web application infrastructure.,
W] Inkernet Information Se K
% E:;tgz;:s ~ Role Services: 23 installed g} Add Role Services |
Hit Configuration Role Service [ status J
55 Storage Cw ‘MebServer Installed
i Installed
4 Installed
P Installed
s Directory Browsing Installed
) HTTF Errors Installed
HTTP Redirection Mot installed
&y Application Development Installed
= ASPMNET Installed
P .MET Extensibilicy Installed
= asp Instalied
= cal Installed
s ISAPI Extensions Installed
) ISAPI Filters Installed
s Server Side Includes Installed
s Health and Diagnostics Installed
& HTTP Logging Installed
Logging Taols Mat installed
P Request Monitor Installed
Tracing Nat installed
Customn Logging Mat installed
ODBC Logging Mot installed
= Security Installed
Basic Authentication Mot installed
Windows Authentication Mot installed
Digest Authentication Nat installed
Client Certificate Mapping Authentication Mot installed
115 Client: Certificate Mapping Authentication Mot inskalled =
4 0| % Last Refresh: #{23(2011 10:18:41 PM Configure refresh

Figure 47 Step 1 — Enabling Static Content
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Step 2 — Updating the Insbridge Application Pool

The Insbridge installation must be complete prior to creating an application pool.

1. Click Start > Administrative Tools - select IIS Manager.

2. Expand the Local Computer and select Application Pools. Right click and select Add
Application Pool.

*E Internet Information Services (1IS) Manager = E
@ (3] [ L} v winsRPODI ¥ application Pocls | & @ -
File  vew Help
- [“E ] lication Pools _
@- i |78 J App (3 add Application Pol...
&5 Stark Page et Application Pool Defaults...
& &2 oot cwiruspon| | This Bage ets you view and mansge the lst of application pacs on the server, Application posls are associated o A
| - with worker processes, contain ane or more applications, and provide isolation ameng different applications. @ Help
& Sites e Add Application Poal... - (a0 - (show Al | Groupby: Mo Grouping < Orline: Help
k& Refresh Status (ET Frame... | Managed Pipeli... | Identit Appl
L Classic .NET AppPodl Started  v2.0 Classic NetworkService i
L DefautappPool started  v2.0 Integrated Hetworkservice 1
L Insbridge Started vz Integrated Insbridge 3
4| | |
4 | 5 Features iew |- Content Yisw
Ready €.

Figure 48 Navigating to Application Pool

3. Enter “Insbridge” for the Application pool Name. Select the v2.0 for the .NET Framework

version. Click OK. You will be returned to the IIS screen. Your new application pool will be
listed.

Add application Pool E I

WENR

|.NET Framewark v2.0.50727

MET Eramework version:

Managed pipeling mode:

v Start application pool immediately
04 I

Figure 49 Creating a New Application Pool

Zancel
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4. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings H

B {General) =)
MET Framework, Wersion w2, 0
Managed Pipeling Mode Inteqrated
Mame Inshridge
Cueue Length 1000
Start Aukomatically True

B Cru
Lirmit 0
Limit: Ackion Modckion
Lirnit Inkerval (minukes) 5
Processar AFfinity Enabled False
Pracessar AFFiniky Mask, 0000000000

E Process Model

Identity Insbridge vun
)

Load User Profile False

Plaxirmum Wworker Processes 1

Ping Enabled True

Ping Maximum Response Time (seconds) 90

Ping Period (seconds) 30

Shutdown Time Limit (seconds) an

Skartup Time Limit {seconds) an
E Process Orphaning

Enabled False -
Identity

[identity Tvpe, username, password] Configures the application pool ko run as builk-in
account, i.e. Mebwark Service (recommended), Lacal Syskem, Local Service, or as a sp...

Ik Cancel |

4

Figure 50 Selecting Application Pool Properties

5. Verify that the .NET Framework Version is v2.0.
6. For the Identity select Insbridge.

7. Click OK to save your changes.

Step 2 — Associate the Virtual Directories with the Insbridge Application Pool

Next, you will need to association the Insbridge virtual directories with the new Insbridge

application pool.

8. Stay in IIS Manager. Under Local Server - Sites - Default Web Site, select IBFA. Right
click and select Add Application.
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Figure 51 Adding Application to Virtual Directory

9. A separate window will be displayed. Select the Insbridge Application Pool.

Add Application E |

SItE name: FimF =k LU AR Sikm

Path: select Application Pool E |

Application pool:

Alias:

I— DefaultsppPool j <Select

DefaultsppPoal
Example: sale

Classic \MET AppPool
Pheysical path: .ﬁe! Eramewur! !ersu:un: !!

Pipeline mode: Integrated

Pass-through

Conneck as. .

s | Cancel

Figure 52 Selecting the OIDC Application Pool
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10. Click OK to save your selections.

11. Repeat the process for IBRU and RM of selecting the Insbridge Application Pool.

12. Restart II1S. On the IS screen, Actions = Restart IIS.
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Figure 53 Restarting |

This issue may be more prevalent on a Windows 2008 64-bit machine. If you are not

IS

experiencing issues, you do not need to create an Insbridge application pool.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System
product, please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, seven days a week. For TTY support, call
800.446.2398.
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